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Introduction

This guide (like the software it deals with) is the result of a long work, writing and editing, which

has been going on since 2007, when the  LibroGameCreator project was born. To adapt to the

technological needs and demands of the writers LGC is changed and will most likely continue to

change  in  the  future,  so  you  will  have  to  forgive  if  the  guide  sometimes  arrives  a  little  late

compared to the news.

This work has been and will always be free, but there are certainly costs and problems in managing

a project that requires software development, site maintenance and occasionally the participation of

external collaborators. Therefore, if you use LGC and are satisfied with it, you can contribute to this

process by clicking on one of these buttons:

If you have any doubts and want to deepen the issues related to the program or the writing of

interactive books you can find other resources at these addresses:

• website: http://www.matteoporopat.com/librogame/libro-game-creator-3

• site in English: https://librogamecreator.wordpress.com

• forum: http://www.librogame.net/index.php/forum/forum?id=13

What you are reading is version 3.4. 139 of the guide, modified on 16/01/2023.

Good reading and as always good interactive writing,

Matteo Poropat

(https://linktr.ee/mttprpt)
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INSTALLATION

INSTALLATION ON WINDOWS
This version requires Windows 7 or newer. At least 2GB of memory and a version of Windows
equal to or greater than 8.1 are recommended.
Download the correct version for your operating system from the link
https://www.matteoporopat.com/librogamecreator-download/
Start the installer by double-clicking on the downloaded file. A wizard will be launched  that will
guide you step by step  through the installation process.

KNOWN ISSUES
Problems with installation are rare, but they can happen.  The most likely cases are described below
and what actions to take to resolve them.

DOWNLOAD BLOCKED
The browser,  when downloading the  file,  displays  a  warning about  the  potential  damage from
downloading the software. Confirm to your browser that you want to continue downloading the file.

MICROSOFT DEFENDER SMARTSCREEN BLOCKS INSTALLATION
Windows has a system that warns you if you are installing a program downloaded from the web, for
its potential danger. In this case you must confirm that the program is safe and continue with the
installation, clicking on More information and on the next screen on Run anyway.

BLOCKED BY ANTIVIRUS
Some antiviruses may perform the same checks. You just need to confirm to your antivirus program
that LibroGameCreator is a safe software.

FILE CORRUPT OR INSTALLATION THAT DOES NOT START
In some cases, when downloading files, they can be damaged or corrupted. The installer checks the
integrity  of  the  packages  before  proceeding  with  the  installation.  If  there  are  some  problems,
download  the  installer  and  try again.  If   the  problem persists  the  copy on the  server  may be
corrupted, report the problem.

PROBLEMS GENERATING GRAPHS
Since version 3.3.3 of  LibroGameCreator the  library is included in the main program, but it
requires more and more available memory, depending on how long and complex the gamebook is.
If the graph export stops without generating the images you can opt for an external installation  of
Graphiz (described in a later chapter of this guide) or increase the memory available for the Java
Virtual Machine by editing the . vmoptions (see next paragraph).

TIPS FOR POWER USERS
The main program and installer contain a series of configuration files that canbe manually modified
to make adjustments where necessary.
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The  options  to  the  Virtual  Machine  running  LibroGameCreator are  contained   in  the  file
lgc3.vmoptions  in  the   installation  folder  (e.g.  on  Windows  it  will  be  in  C:\Program
Files\LGC3\lgc3.vmoptions  and bring the maximum memory value from one to  two gigabytes,
changing the parameter -Xmx1024m to -Xmx2048m).

INSTALLATION ON MACOS
Proceed with the following installation steps:

1. download Disk Image (DMG) file
2. click on the file to mount the image
3. after a few moments a window will appear showing the contents of the image
4. double-click the icon to start the installation. From OS X 10.8 onwards you need to follow

some additional steps described later
5. waita few seconds for the installer to start
6. follow the installation wizard step by step 

INSTALL ON OS X 10.8+
From this version the operating system has a feature known as Gatekeeper that prevents the opening
of files from unsafe sources, typically downloaded from the internet. To start the installer you must:
instead of double-clicking the icon, use Control+Click (or right click) then choose Open.
A dialog box will appear to warn you that the file has been downloaded and is not safe. Confirm
that you want to open the file. Click Open and start the installer.

INSTALL ON OS X 10.10+
There is a bug in Java versions prior to Java 8 update 20 that prevents the program from starting on
OS X 10.10.  If  you have  the  Java  version  installed,  proceed to  update  it  before  installing  the
program.

INSTALL PORTABLE VERSION
The portable versions does not contain the installer, does not update automatically, and can be run
from the folder where you unzip the file downloaded from the site.
For this to be possible on the PC must be installed Java, usually already present, with a version
equal to or greater than 8.
To make sure the correct version of Java is installed, just open a terminal window and run the
command
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java -version

If the result looks like this, the system is ready.

java version "1.8.0_144"Java(TM) SE Runtime Environment (build 1.8.0_144-b01)Java
HotSpot(TM) 64-Bit Server VM (build 25.144-b01, mixed mode)

Otherwise an error message will be displayed, because either Java is missing or the version is not
the correct one. You must download and install Java for free by following the instructions at this
address: https://www.java.com/it/download
In order to unpack the archive you will need a program like 7Zip (on Microsoft Windows systems,
while on Linux there is already software to decompress the tar.gz file).

Installing LibroGameCreator on your computer is a very quick operation:
• download the file (.zip for Windows, .tar.gz for Linux/Mac)
• unzip the file to a folder on your hard disk. This will create an lgc3 subfolder with the

startup files inside:
◦ run.cmd (for Microsoft Windows systems)
◦ run.sh (for Linux and MacOSX systems)

STARTUP (ON WINDOWS)
To start the program double-click on the run.cmd file.

STARTUP (ON LINUX AND MAC)
Before you can start the program you must make the file executable run.sh

• open a terminal window
• move to the folder where there are unpacked files
• run the command

chmod a+x run.sh

• run the command

chmod a+x make-desktop-link.sh

• you can start the program from the terminal with the command

./run.sh
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THE GAME CHAPTER

LibroGameCreator was born mainly  as a program for the creation of printed gamebooks,  so it
presents tools such as export to RTF format and shuffle, useless for those who want to develop an
interactive adventure for the web.
The "game chapter" is in any case the founding unit of the gamebook and consists of the narrative
part and links to other chapters (which in the following we will also call references or links). These
are defined by tags, which can be inserted with a keyboard shortcut or by clicking the right mouse
button.

Each chapter within the book is therefore defined by three parts:
• the text, with a possible internal interactive part (dice rolls, variation of game scores,... )
• outgoing references, to other chapters
• incoming links, from other chapters.

14.
You are in the thick of the forest and the path you followed becomes less and less marked. If you
have the sorcerer's map go to 15 while if you have the hunter skill go  to 16, otherwise you continue,
relying on your instinct alone, to 17.

Inserting and editing text takes place as in any word processor, with the ability to delete, insert,
copy, paste and change formatting styles.

Chapers are inserted:
• right-clicking on the chapters tree and selecting New
• clicking on a link between chapters that points to a chapter that is not yet defined

Using the right  button or  the icons  above the chapters  tree you can edit  a  chapter  or delete  it
permanently (operation that you can not undo).
Once added, chapters appear in the chapters tree to the left of the interface.

In the chapters tree, which represents the structure of the gamebook, you can see the small icons
next to the chapter's number. The icons are colored differently, with the following meanings:

blank chapter, contains no text

chapter with notes (text included in a {todo) tag

chapter opened in the editor

CHAPTER ATTRIBUTES
Each chapter can have any number of attributes, but to be able to insert them you must use the
advanced mode, used by those who use LibroGameCreator to  produce a set of data to be used
with dynamic apps, for example for smartphone. For now, let's stick to the basics, more than enough
to write a gamebook to  export in RTF format for printing or in HTML to be viewed on the web.
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THE TITLE
The title is used to recognize a certain situation by scrolling through the tree of paragrafi but can be
used automatically during export instead of the chapter number, inserting the links between chapters
in the extended format that we will see in a dedicated appendix at the end of the guide.
To change the title just double-click on the number and change the title text in the edit mask or click
on the chapter and then use the F2 function key.
The title is also given in the graph of the book.

FIXED
This attribute was necessary to lock the chapter when the book is applied to the shuffle algorithm
(or shuffle) that allows you to keep distant chapters linked to each other, which would end up in
sequence once printed on the page.
The presence of the attribute is indicated by a small red padlock :
A fixed chapter is colored red when exporting the graph.

EXPORTABLE
You can mark chapters so that they are not included in those exported in various formats. To set the
attribute right-click on the paragraph and select the icon
At this point in the tree the chapters page will include an X to indicate that it is not exportable.

HASHTAGS
To personalize the chapters you can assign hashtags that define the essential characteristics. Two
hashtags are standard and indicate a positive (goodending) or negative (badending) conclusion of
the story. Others can be added by clicking on the icon  , inserting a string (of letters and numbers
only) and choosing the color. Hashtags are indicated in the editor, in the chapters tree and have a
dedicated search. To delete them just click on the hashtag with the right button.

GROUP
Chapters can be merged into modified groups by entering a non-empty value in the Group field  of
the editing window. Groups can represent different parts of the book, such as chapters, sections, or
even history, temporal, or geographical areas.
Once a group has been created, chapters can be added or deleted by dragging them into or out of the
group folder using the mouse over the chapters tree.
As you will see later, in the export of the game graph the groups are indicated as colored boxes,
containing all the chapters that are part of it.
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LINKS BETWEEN CHAPTERS
As we have already seen, the game chapter consists of a narrative text and one or more choices,
which lead to other chapters.
Links or cross-references between chapters must be specified within the text, so that at the time of
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export they can be transformed into the desired format (for example,  into hyperlinks in HTML
format).

The links can be inserted using two different formats, based on what is the target you want to reach,
choosing the most suitable one in the Preferences.

• short format: it is the default format and is perfect when you intend to write a text to publish
it in paper format. The short format consists of the paragraph number between two square
brackets, for example: you head into the forest at [104];

• extended format: it is the most complex and complete format, to be used for documents
where the chapter number is not needed but text links are preferred, such as HTML for the
web, interactive PDFs or apps. This format will be analysed in a dedicated appendix of the
guide.

Incoming and outgoing links are listed next to the chapter number, in the interface above the editor.

HOW TO INSERT A LINK
To insert a cross-reference to a new chapter you do not need to manually write the entire link tag,
but you can use keyboard or mouse shortcuts:

F5 or F3 function key
• inserts in the text a complete link to the first available chapter number (e.g. [102])
• create the new chapter (e.g. chapter 102)
• move the cursor to after the cross-reference, allowing you to continue writing

right-click mouse
• you can also insert a reference by right-clicking and selecting the option "insert a link to a

new chapter" from the menu.

Clicking on the links in the testor loads the relevant chapter. If the chapter does not yet exist, an
empty one is created and you can start writing about it.

The links will then also be displayed in the export of the game graph, seen in the previous image.

NOTES
It happens to have to write, together with your text, reference notes, to remember corrections to be
made or to write down codes or solutions to the proposed puzzles, which will be eliminated during
export.
Born as reminders  of things to  do,  for similarity to what  is  used for example in programming
languages, the notes are inserted using the following annotation:

{todo text of the note}

The most important thing is to remember that when you export your book, to an RTF file or HTML
file, all notes will be removed.
You can view and save the list of inserted notes to a text file by choosing the Notes List option on
the View menu or the  Notes list icon in the toolbar

11



Guida a LibroGameCreator

INVISIBLE BINDING
If we put together what we have just seen on the todo tag and what we know about the
links between chapters we get a very useful trick in writing gamebooks that  contain
puzzles, that is, the possibility of inserting links between chapters in the text that must
remain invisible to the reader, but instead be well readable by the author and present in

the book graph.

Suppose we have a riddle in paragraph 12, whose resolution is a numerical value to be added to the
chapter number, to move to the correct one.

The text of chapter 12 could contain text such as

If you have solved the riddle add the number obtained from that to this
chapter and move to the destination to continue.

To findout which is the correct solution, while writing and testing the gamebook, you can add a note
like the following:

{todo riddle, solution = 15, go to [37] }

The two chapters will be connected and traces remain of the  solution of the riddle while in export,
for example in RTF or HTML format, the text contained in the internal note is not displayed.

It is important to note that even in the case of exporting the game graph the two chapters related to
the puzzle are correctly connected.
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THE CHAPTER INTERFACE
Many of the elements we have talked about so far are displayed at the top of the interface. In the
center we see the chapter number with icons that allow you to return to the previous chapter, set the
status of "fixed" and the pin to open, if present, the chapter on the game map.
On the left are the incoming links, towards the open chapter.
On the right are listed the outgoing chapters, from this chapter to the others, and then there are the
hashtags assigned to the chapter.

From this visualization you can notice many useful things when writing.  If  there is  a
numerical puzzle in the chapter as seen above, both this and the outbound linked chapter
must be set as fixed. In the two side blocks, the fixed chapters appear as red buttons with
the number in white. In the same way, if you are in the chapter solution of the riddle, this

and the one from which you arrive must be fixed.

Hashtags can be equally useful in writing, emphasizing the presence in the chapter of
recurring elements that you want to keep track of. For example, you could assign the
corresponding  hashtag  a  keyword that  in  the  chapter  is  given  to  the  reader  or  is
requested. Using hashtag search we are able to check where this keyword is used and

track it within the text.
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WRITING TOOLS

Together  with  the  most  basic  tools  (text  search,  file  backup,...  ),  others  have  been introduced,
dedicated exclusively to interactive writing, such as structure validation and reading history.  These
are very important tools for those who dedicate themselves to gamebooks and we will analyze them
in detail.

VALIDATION
The validation of the gamebook allows to verify the correctness of the references, to avoid problems
of consistency of the text. In the case of "hidden" references, related for example to puzzles, it is
possible to create a link that will not be exported but that will be verified (and displayed in the
graph).
The validation of the gamebook starts from the  button in the main bar or from the Book menu.

Errors with three different levels of severity:
• empty chapter,
• no incoming links, leading to the active chapter. It can be a symptom of a missing link, for

example in a puzzle, not correctly connected to the solution;
• no outgoing links to other chapters. Any attributes that justify this lack are also checked:

the presence of standard hashtags #goodending or #badending (the chapter concludes one
of the  narrative branches of the book in a positive or negative way);

• link a non-existent chapter.

Clicking on a row in the results table will move the editor to the chapter.

The entry chapter of the book, usually number 1, is the one from which the story begins
and is shown by validation as incorrect as there are no incoming links. This is because, as
in some classic gamebooks,  the story may start in different chapters, such as from a table
in the rules.  To avoid displaying this  false positive among the validation results,  just

insert in one of the sections (such as Rules or Introduction) a reference to the initial chapter.

READING HISTORY
The History is a tool created for the need to automatically record the path taken while reading, for
example by a beta reader.
To save a reading sequence you must  open the panel,  using the key in the top bar or the key
combination CTRL + H.
You will see in the section on the right the list of what has been read so far. The reading list can be
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reset with the X button at the bottom right, while you can save to files with the button on the left.
You can also edit it, writing directly next to the chapters, to take notes while reading/testing the
book.

BACKUP
The program makes two types of backup copy of the file being written:

• automatic backup: it is performed every 5 minutes (a p artire since the last save, automatic
or manual, and only if the file has been modified in the frattemo), in a file whose name is
equal to that of the open file preceded by a symbol (~)

• manual rotation and backup: when you save the file, the previous version is numbered
progressively and saved separately, in a file that will have the name of the original with the
extension .bak1, .bak2,...  The last five versions of the text are saved.

STRUCTURE OR INDEX OF THE GAMEBOOK
The structure of the gamebook is useful to manage the export of the sections of the book together
with the chapters. Selecting  the  Structure item from
the Book menu  opens the relevant window.

On the left there is a list of all the Sections included in
the  text,  including  the  block  of  game  chapters
highlighted in yellow. On the right there is the current
book index,  composed  of the  Sections that will  be
part of the text in exports. The Sections can be moved
between the two sets with a simple  drag & drop, and
are reordered at  the same time (you can select more
than one using CTRL + mouse click  or select them all
with the shortcut CTRL + A).

The index of the book is saved in the file along with the other data.

SECTIONS
Sections are   parts  of  text  that  make  up the  interactive  book even  though they are  not  game
chapters. Sections can be created, edited and deleted as chapters and as those they are defined by a
name (an alphanumeric identifier such as "rules") and a title (for example "Game Rules"). When
exporting the file, priority will be given to the title and only in the absence of this will the name be
used.
With the  Sections you have the opportunity to introduce texts such as the introduction and the
epilogue, the rules, the colophon, the thanks and so on, sectionsthat we find in each book.
To add a section right-click on the tree and select New  (or click on  the New icon above the chapter
tree), then select  the Section type  and enter at least the name field.
Sections can be placed in your favorite part of the book, using the Structure tool, described below.
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INFORMATION
In the information window, accessible from the Book menu, you can enter the name of the author,
the title of the  book and a possible version of it.

The number of characters and  the word count in the text are also shown  (the digits that make up
the paragraph numbers are also counted).

GLOBAL VARIABLES
You can define keywords to which you attribute a value (e.g. @maincharacter="Lone Wolf") and
insert them into the text, so that they can be expanded later when exported.

16



Guida a LibroGameCreator

THE GAME MAP

LibroGameCreator is equipped with a map manager, which allows you to link the
written text to images, chosen by the user, which represent the areas in which the
story is articulated, for example the map of a basement, a house or a geographical
region .
To open the map manager click on the map icon in the top bar, after creating a new
project.

In the window that opens, you can upload multiple images from the Map menu > Upload a new
map. Once the image is loaded, using the right button adds the link to one of the paragraphs of the
adventure you are writing.

In this way it will be possible to:
• from the map, by clicking on the box with the chapter number, return to the text editor
• from the editor,  clickon the pin icon  ,  the  map will open and move to the image that

contains the chapter.
To remove a link from the map right-click on the box and select Remove from the drop-down menu.
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RESHUFFLE THE CHAPTERS

One of the problems of printed books with interactive writing is finding yourself with chapters of
play linked together by a reference and close on the page. The author normally does not want the
reader to see the effects of his own choice and if this is written a few lines later it is impossible to
think that he is not going to peek.
In a text written for a digital device,  which will display only one chapter at a time, you will not
have to address these issues.

THE SHUFFLE FUNCTION 
To overcome the excessive proximity or proximity between connected chapters, the function known
as shuffle  is used.
Imagine chapters as cards in a deck, they are shuffled multiple times, keepingat least one chapter
away from those to which it is connected.
Over time the  shuffle has evolved, to meet the demands of writers, to divide into three variants
described below.

100
One of the two doors in front of you leads to the necromancer's abode, you just have to enter and
end his existence. On one of the two is engraved a yellow hieroglyph, on the other the symbol of an
animal skull. Do you wield your sword, load your muscles, and throw yourself into the hieroglyph
room or (go to 101) or kick and attack who is in the room behind the skull (go to 76)? 

101
The floor is not there, and this is the strange thing. Much more natural is the action of gravity that 
drags you into astone gut app arenately bottomless, where your cries will continue to echo until 
death reaches you. 
Your adventure ends here.

What does this passage teach us? Surely you do not throw yourself headlong into the private rooms
of a necromancer but, from the point of view of a writer, that such a crossroads is useless. Having
access to the effect of their choice, no reader will opt for that derivation that printed so is a single
huge "spoiler" on the story.
Applying the shuffle  instead,  the text of the paragraphs will  remain unchanged,  apart  from the
references. For example, 101 will be replaced by 12 and 12 will replace 101.

12
The floor is not there, and this is the strange thing. Much more natural is the actionof gravity that 
drags you into a seemingly bottomless stone gut, where your cries will continue to echo until death 
reaches you. 
Your adventure ends here.

100
One of the two doors in front of you leads tothe necromancer's death, you just have to enter and end
his existence. On one of the two is engraved a yellow hieroglyph, on the other the symbol of an
animal  skull.  Do  you  pick  up  your  sword,  load  your  muscles  and  throw  yourself  into  the
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hieroglyph's  room (go to 12) or do you kick and attack who is in the room behind the skull (go to
231)? 

Applying the shuffle on the book solved the proximity problem.

IMPORTANT: FIXED CHAPTERS
One of the fundamental nodes of the reshuffling procedure concerns fixed chapters, i.e.
those chapters to which,  from the interface,  the fixed attribute has been assigned (by
clicking on the chapter and then on the icon with the red padlock).
As already seen in the chapter dedicated to the writing of the chapter, if this is fixed it is

not modified by the shuffle procedure.
This is fundamental because if we have numerical puzzles to solve, for example, whose result must
be added to the chapter of the puzzle to find the correct reference, both chapters (the one where the
puzzle is present and the one where the solution leads us) must be fixed so that the book remains
playable.

TYPES OF MIXING
The mask of the shuffle shows three blocks of chapters: the complete book and two separate blocks.

Shuffle of the entire book: all the non-fixed chapters of the entire book are reshuffled together. It is
the most common method of shuffling, used by gamebook writers.

Shuffle of a block of chapters:  all the chapters that belong to the set selected by the user are
reshuffled together. A useful expedient for example in the case of a  book divided into sections,
where from 1 to 200 you have a certain narrative, from 201 to 400 the next part of the story and so
on. If the writer wants the reshuffling to be done in parts he can take advantage of this possibility.

Shuffle between two blocks of chapters: all chapters in a set A are reshuffled with those in set B.

Shuffle of a block of chapters n the restof the book: a certain set of chapters is reshuffled with the
chapters in the rest of the book.
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EXPORT YOUR GAMEBOOK

Once you have written your interactive work or gamebook, it is time to export it in the format that
you consider most useful for your purposes.
As previously mentioned, LibroGameCreator was born as a tool oriented to those who write to be
able to print their works on paper. For this reason it has functions such as reshuffling game chapters.
and for the same reason the first export has historically been the one addressed to publication in the
RTF (Rich Text Format). To this have been added the formats to be able to play online (HTML) and
only more tar of a whole series of file types that meet the most digitally oriented needs.

BOOK EXPORT
To save the book in a different format  All exports are launched  from the Book > Export menu  or
from the buttons in the top bar.
Formats that need formatting styles (RTF, HTML, eBook) embeds the file with styles that can be
edited by the user in the settings panel accessible from  menu File > Editing >Preferences.
The resulting file will contain the sections specified in the book's index, as explained before.
Game chapters will be identified by chapter's numbers. To export chapters titles instead, see the part
of these guide about links and titles.

RICH TEXT FORMAT (RTF)
An RTF file is editable by most text editors such as Microsoft Word or Open Office. Once
opened in Open Office, for example,  you can export it in PDF format, obtaining a playable

file, with active links between the chapters.

HTML (SINGLE FILE)
A single HTML file is exported that contains the entire book, embedding the user-defined style
file. The links between chapers are active and in reading clicking on a link you move to the

relevant target chapter.

HTML (ONE FILE PER PARAGRAPH)
An HTML file is exported for each of the game chapters and for each of the sections of the
book. Each HTML file  embeds the user-defined style  file.  The links between chapters are

active and reading clicking on a link opens the relevant target chapter file in the browser.

EBOOK (EPUB)
An eBook contains the sections that belong to the index, linked together by active links.  The
ebook file is in ePub 2 format and can later be edited by special editors such as Sigil. In order

to export a gamebook in eBook format,  you will be asked for the image to be used as a cover of the
electronic book.

CHOICESCRIPT PROPERTY
CS is a proprietary format created by Choice of Games, which allows its users to use it to write
interactive  stories  and  provides  a  service  for  transforming  the  file  (purely  textual)  into  a

smartphone app.
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SQUIFFY
Squiffy is a format made available by the site TextAdventures, derived from the more complex
Quest (oriented to text adventures). You can export a gamebook in  the Squiffy format and

upload the resulting file to the site to test and play online.

DATABASE SQLITE
The SQLite format  has been added to take advantage of its synergy with Android applications.
The  SQLite  data  source  exploited  in  import  and  export  by  LibroGameCreator,  is

defined by two simple tables. The first lists the entities (chapters, sections but also, if activated in
Preferences, the other entities created by the user), in the second the attributes related to each of
them.
Below is the SQL code to create the two tables that make up the database.

CREATE TABLE T_ENTITY (id_entity INTEGER NOT NULL PRIMARY KEY,entity_name TEXT NOT 
NULL,entity_type TEXT NOT NULL,entity_group TEXT NOT NULL);

CREATE TABLE [T_ENTITY_ATTRIBUTES] (id_entity INTEGER NOT NULL CONSTRAINT [FK_ENTITY] 
REFERENCES [T_ENTITY]([id_entity])ON DELETE CASCADE ON UPDATE CASCADE MATCH 
FULL,id_attributes INTEGER NOT NULL,attribute_name TEXT NOT NULL,attribute_type TEXT 
NOT NULL,attribute_value TEXT NOT NULL,CONSTRAINT 
[sqlite_autoindex_T_ENTITY_ATTRIBUTES_1] PRIMARY KEY ([id_entity],  [id_attributes]));
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IMPORT FILES FROM OTHER FORMATS

The import was born from the need to be able to edit with  LibroGameCreator texts written in
other formats, mainly in the simple text format. Later other functions were added , for a better one
with previous versions and with other writing systems.

IMPORT
To import a gamebook from  an external file, choose Book > Import from the menu and the format
you want.

PLAIN TEXT
The source must be a generic text file, formatted by alternating the number of the chapter with the
text of the same. For example,:

1.
It's the end of the usual working day, greetings everyone in the office, wishing you a
good weekend and taking advantage of the elevator fortunately already available on
your floor to go down to the company parking lot.

The chapter identification number may or may not have the period (so both 1 and 1  are fine). In
order to correctly convert the cross-references, the program must be able to recognize the links with
the other chapters, specified by text similar to "go to 100", "read 36" and so on. To make this
possible, a special file has been created containing all the cross-reference formats, which is located
in  the   configuration  folder  (on  a  Microsoft  Windows  system,  for  example,  it  is  located  in
C:\<userfolder>\.lgc3\cfg\txtkeywords.list).
The file contains the list of cross-references, in all languages.

LGC2
You can import files written with the previous version of GameCreator (LGC2).

SQLITE
You can import the data contained in a SQLite database, if the tables have been defined according
to the format already seen in the chapter of the guide dedicated to export.

SQUIFFY
LibroGameCreator able to import a text file  in Squiffy format, reconstructing the structure of the
links between the game chapters and enhancing the titles of these, if they have been specified in the
links as per format specifications.
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FOR EXPERTS: EXTENDED LINKS

We have seen previously that there are two formats of connection between chapters, the standard or
"short" and the more complex one called "extended", to be used in HTML applications or Apps
where it is usually not necessary to indicate the chapter number and you want text links.

In this case the link has the following format:

{ target link:text}

where:
• destination is the chapter to which you arrive by following this link;
• text can consist of

◦ a number of chapter (ex:{link 100:100})
◦ one or more words (ex:{link 100:forest})
◦ the special tag @T (ex: {link 100:@T}) in this case, if the chapter to which the reference

points has a title and the  option use  titles for links is specified in the  Preferences,
during the esp ortation the link will be transformed using the format:

{link number:title}

HOW TO INSERT A LINK
The same applies to short-format links, you can insert them by writing the entire tag, using the F5 or
F3 function keys or the right mouse button in the editor.

LINKS AND CHAPTER TITLES
When the link is inserted (manually or using the F5 key) in the extended format {link number:@T},
exporting the gamebook will have different results, depending on your needs and the values set in
the individual chapters.
In the Preferences panel of the File menu, you can enable the Use chaper title in links option.

Suppose you have the following text of a chapter

If you have the sword of the sun go to {link 100:@T} while if you have the sword
of the moon go to {link 110:@T}.

and want to export it in RTF format, to be opened later in Microsoft Word or OpenOffice.

Exporting will give the following results.

• If this option is disabled:

If you have the sword of the sun go to 100 while if you have the sword of the
moon go to 110.

• If the option is enabled, and the two paragraphs have no title:

If you have the sword of the sun go to 100 while if you have the sword of the
moon go to 110.
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• If the option is enabled and the two paragraphs each have their own title, which we suppose
is temple for  100 and port for 110:

If you have the sword of the sun you go to the temple while if you have the
spada of the moon you go to the port.
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FOR EXPERTS: INSTALL AND CONFIGURE GRAPHVIZ

Graphviz is a library to generate graphs, exploited since the first versions. Its installation is very
simple on Windows but has some problems on other systems, especially on Mac OS X. The official
website of Graphviz is: https://www.graphviz.org

It is important to note that since version 3.3.3 of LibroGameCreator, the Graphviz library
is  included in   the main program and it  is  usually not necessary to proceed with its
installation, described in the following paragraphs. This is unless you have problems in
creating graphs, due for example to an insufficient amount of memory, so it is necessary

to have a process external to the program that creates the images.

INSTALLATION AND CONFIGURATION ON WINDOWS
1. download the .msi file  from the Downloads page
2. start the installation (double click on the MSI file) and follow the on-screen instructions
3. once the installation is complete, launch  GameCreatorBook and  open the configuration

panel, selecting the File menu  and then Preferences
4. in the Graphviz section, enter the path to the dot.exe executable file. If you have installed

Graphviz   in  a  folder  other  than  the  standard  one  (C:\Program  Files
(x86)\Graphviz2.38\bin\) copy here the path to the subfolder including bin, otherwise you
do not need to change anything

5. save your preferences.

INSTALLATION AND CONFIGURATION ON LINUX
The installation procedure on Linux systems differs according to the distributions. On the site you
will find links to download installers of the main distributions, but you can also do so using package
managers. Resume themethod for the most widespread distribution, Ubuntu:

1. the package is ready in the official repository, you can use the visual package manager or
open a terminal and run the command sudo apt-get install graphviz

2. once  the  installation  is  complete,  start  the  program  and  open  the  configuration  panel,
selecting the File  menu and then Preferences

3. in the Graphviz section  you must enter the path to the executable file,  dot. In the case of
Linu x distributionsthis path is one of the following:  /usr/local/bin/ or /usr/bin/ you can test
both or, from the terminal, run the locate dot command  to find the correct path 

4. copy the path to the included BIN folder  and save your preferences.

INSTALLACTION AND CONFIGURATION ON MAC OS X
The process is similar to that seen for Linux distributions, and depends on the "missing package
manager  ". The tests were done with  Homebrew (but it should be possible to use  MacPort as
well).

1. if non is already present in the system install Homebrew with the command on the  official 
website: https://brew.sh/index_it/usr/bin/ruby -e "$(curl -fsSL 
https://raw.githubusercontent.com/Homebrew/install/master/install)" 
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and follow the on-screen instructions
2. installate  Graphviz  with the command brew install graphviz
3. start the program
4. open the configuration panel, selecting the File menu  and then Preferences
5. in the Graphviz section  you have to enter the path to the executable file, dot. In tests 

performed witha Mac system the path was:  /usr/local/Cellar/graphviz/2.40.1/bin/
to check if the path is correct you can use the command
locate dot

6. copy the full path to the bin folder in the Preferences mask  and save.
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FOR EXPERTS: MANAGE STYLES

Customizing the format of the game chapter is a need that sooner or later you will feel, working on
your own book. As I mentioned before, LGC was born mainly to manage the structure of the book,
and its "word processor" features are minimal.
At the present time what can be done is to act on a file that contains the skeleton of the chapter, a
so-called template, to obtain some useful effects. In future versions I will try to make these steps
more friendly.

These customizations can have different effects depending on the program you use to
open your RTF file. The tests werecarried out with the free OpenOffice package, but the
result may differ if you use LibreOffice  or Microsoft Word, for example.

FORMAT THE CHAPTER NUMBER
Assigning certain formats to the chapter number, displayed before
the paragraphitself, is very simple, although it requires a minimum
of knowledge of HTML styles, therefore of the so-called CSS. As
far as basic needs are concerned, just access the editing menu (File >
Preferences, Editing tab) and click on the item, in the left column,
div.chapternumber.

The middle column displays the standard attributes. For example, to
change the alignment by putting it on the left, simply edit text-align:
center; to text-align: left; and in the same way you can change the
margins and color of the text of the chapter.

Once  the  change  has  been  made  by  clicking  on  the  highlighted
button this is applied and it will be possible to see the effects live in
the right column that shows an example of chapter.

TITLE AND NUMBER OF THE CHAPTER BEING EXPORTED
As already seen in a previous section of the guide, it is possible to give each chapter a title. This is
to be able to identify it more simply in the paragraph tree, in the section on the left of the interface.

If you do not want the titles to be exported (in RTF, HTML,...) both as a chapter title and in the link
text (see the chapter attributes part of this guide) you must disable the Use chapter titles in links
option,  in  the  configuration  panel  located  in  File >  Preferences.  With  the  option  disabled  in
exports, chapter numbers will be used instead of headings.

This feature can be used to create HTML or mobile applications, where the chapter number is not
useful. In this case, as explained in the help section above, using the links in the extended format
(e.g. {link 2:@T} that are obtained with  the F5 shortcut) and activating the Use chapter titles in
links option, the title string will be used in export both in the links and in the actual title of the
chapter (so in the text we will not find a reference like go to paragraph 2,  but go to the <title of
chapter 2>) .
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CHANGE THE CHAPTER VISUALIZATION
To further manipulate the format of the chapter, you can opt for something more radical, going to
change the chapterRTF file.html which is located in the folder identified by the path
C:\Users\<username>\.lgc3\cfg\template

To access it simply open Windows Explorer and paste the string
%USERPROFILE%\.lgc3\cfg\template
as in the following image:

Now with a text editor open the chapterRTF.html file. You will see an output similar to the same (I
always recommend using Notepad++ to do these jobs):

For example, to always export the chapter number regardless of the option we talked about in the
previous part, just change the string NAME to the string NUMBER. In this way, even if chapter
titles are used in editing, the number will be used during export.

Saving the file and exporting again will see the result of the change.
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